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About the Author 
Richard Carter is a frontend web developer with a passion for integrating designs in a 

range of open source e-commerce and content management systems, including Magento, 

MediaWiki, Joomla!, and Drupal. His expertise has led clients including University 

College Dublin, Directgov, NHS Choices, and BusinessLink (http://www. 

businesslink.gov.uk), to consult his knowledge on open source systems. 

Richard is Creative Director at Peacock Carter Ltd (http://peacockcarter. 

co.uk), a web design and development agency based in the North East of England. He 

graduated from the University of Durham in Software Engineering, and currently lives in 

Newcastle-upon-Tyne. He blogs at http://www.earlgreyandbattenburg. 

co.uk/ and tweets at http://twitter.com/RichardCarter. 

Magento 1.4 Theme Design is the author's fourth book: Richard has previously written 

MediaWiki Skins Design, Magento 1.3 Theme Design, and Joomla! 1.5 Templates 

Cookbook, and has acted as a technical reviewer on MediaWiki 1.1 Beginners Guide and 

Inkscape Illustrator's Guide. 
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Magento 1.4 Themes Design 
Magento is a popular open source e-commerce project. While it comes with a number of 

'default' themes to change the look and feel of your store, many people both new and old 

to Magento struggle with even the more basic aspects of customizing Magento themes. 

When you read this book you'll see how to change the basics of your Magento theme, 

create a new custom theme, and much more. 

The book is a step-by-step guide to theming Magento, aimed at readers with little 

technical expertise. 

In short, the book guides the common aspects of theming and customizing Magento 1.4 

and an equally useful step-by-step walkthrough of integrating more unusual items into 

your Magento store. 
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What This Book Covers 
Chapter 1, Introduction to Magento, introduces Magento, including the installation  

of the software and avoiding common pitfalls in this process. This chapter is an 

invaluable guide for those who are new to everything in Magento, or just those who are 

new to Magento 1.4. 

Chapter 2, Exploring Magento Themes, introduces theming in the context of Magento 

and covers terminology used within the Magento project that relates to Magento in a 

wider context—from interfaces to packages—and more specifically, theme terminology, 

from skins to layouts, and template fi  les. 

Chapter 3, Magento Theme Basics, covers the basics of Magento theming, from changing 

your store's color scheme to updating your store's logo. This chapter concentrates on 

altering existing Magento themes to achieve the theming aims for your store. 

Chapter 4, Magento Theme Layouts, provides an overview of what a layout is in the 

context of the Magento system, related terminology including layout handles and layout 

actions, and uses a number of useful step-by-step guides to common tasks you may need 

to use within Magento to create your theme. 

Chapter 5, Non-default Magento Themes, covers the building blocks of creating your 

own Magento 1.4 theme, from replicating the necessary file hierarchy for your theme to 

enabling your new theme, styling your store's search feature, and altering your store's 

footer area. 

Chapter 6, More Magento Theming, built on the previous chapter's content, from 

integrating @font-face fonts into your Magento store for higher-fidelity typography in 

your Magento store to customizing your store's navigation. 

Chapter 7, Customizing Advanced Magento Layout, looks into more advanced 

customization and manipulation of Magento layout in order to customize your  

Magento store. 

Chapter 8, Magento E-mail Templates, looks at customizing e-mail templates that are 

used to contact customers during key processes of their interaction with your Magento 

store, as well as integrating the well-known e-mail newsletter system-CampaignMonitor. 

Chapter 9, Social Media and Magento, guides you through integrating popular social 

media websites—Twitter and Facebook—with your Magento store, from adding a 

Facebook Like button to your store to adding your latest tweets to your Magento store. 

Chapter 10, Magento Print Style, sees you creating a custom print stylesheet to better 

allow your store's customers to print key pages from your store. 
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Magento Theme Layouts
You've seen some reasonably simple techniques to customize your Magento store, 
so now is the time to delve deeper into Magento theming. This chapter covers the 
following:

• Defi nitions for layout terminology in Magento
• Enabling template path hints to help you customize more easily
• Enabling block name hints
• An introduction to XML
• Changing page layout in Magento through XML layout

This chapter will focus on customizing an existing Magento theme more, subsequent 
chapters cover beginning a Magento theme from scratch.

Magento layout terminology
  Layout fi les in Magento defi ne which content blocks, as defi ned in Magento template 
fi les (.phtml), are positioned within Magento skeleton templates (which are also in 
the .phtml format), that defi ne the overall structure of your store's theme. Magento 
layout fi les are in the XML format (.xml) and are located in the app/design/
frontend/your_interface/your_theme/layout/ directory of your Magento 
installation.

While you will encounter more defi nitions used to differentiate between aspects of 
layout within Magento, there are two defi nitions of use at this point:

1. Default layout
2. Layout updates
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Default layout
  Default layout in Magento refers to the pre-existing layout that defi nes the blocks 
throughout your Magento theme: default layout tells your store exactly in which 
structural block (for example, header, footer, left-column) to place the smaller blocks 
(for example, search box, My Cart block, newsletter subscription form, page content) 
and is generally defi ned in your Magento installation's base theme.

Layout updates
  Layout updates in Magento overwrite the default layout for specifi c views in 
Magento, such as the checkout page or the product details view. In Magento, layout 
updates are used to change the base theme's layout part by part instead of entirely 
overwriting the layout defi ned. For instance, your theme may use a layout update 
to change the blocks displayed in a column in your theme for a specifi c page such as 
your store's homepage, but for other pages Magento's default layout will be used to 
determine which blocks appear where in your page.

Template Path Hints and Block Name 
Hints
  As you've seen, Magento themes can be baffl ing to those who are unfamiliar with 
how Magento and Magento themes work. Useful tools to help overcome this when 
developing Magento themes are Template Path Hints and Block Name Hints. The 
Template Path Hints displays the (relative) path to each of your store's blocks within 
Magento's theme directory structure, that makes it easier for you as a Magento theme 
designer to customize the necessary fi les to change your Magento theme.

Enabling Template Path Hints
 Enabling Template Path Hints displays the path to each template used within your 
Magento theme. To enable this feature of Magento, log in to your Magento store's 
administration panel and navigate to System | Confi guration:
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 Next, you will need to change the Current Confi guration Scope to Main Website or 
Default Store View as the option is unavailable in the Default Confi g scope:

 From the left-hand column, select Developer from under the ADVANCED options:
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If you now enlarge the Debug section in the right-hand column of the page, you 
should see three options as follows:

• Profi ler
• Template Path Hints
• Add Block Names to Hints

At the moment, you only need to use the Template Path Hints option, so uncheck 
the checkbox next to it and select Yes from the drop-down fi eld to enable this feature:

If you now click the Save Confi g button at the top-right of your screen, Template Path 
Hints should be enabled. To see them, simply refresh your Magento store's frontend:
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 You'll also see that the footer has the relevant fi le paths displayed:

 That's it, Magento Template Path Hints are enabled now. If you look at the search 
form, you'll see that the template path displayed relates to the path relative to the 
root of your Magento installation, the value is: frontend/base/default/template/
catalogsearch/form.mini.phtml:

Other templates are displayed similarly, allowing you to see exactly where specifi c 
blocks in your Magento theme are held, which can greatly help when developing 
simple Magento themes.
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Enabling Block Name Hints
 As an additional layer of help when creating and modifying themes, Magento also 
has a Block Name Hints option, which is useful in debugging a Magento theme's 
layout, as it displays the name attribute used in Magento layout fi les. Remaining 
in the System | Confi guration | Advanced | Developer section of your Magento 
store's administration panel, open the Debug section in the right-hand column of the 
page, ensuring that you are either in the Default Store View or Main Website scope 
instead of the Default Confi g scope.

Uncheck the checkbox next to Add Block Names to Hints and select Yes from the 
drop-down fi eld to enable this feature.

Save this change by clicking Save Confi g at the top-right of your screen (you can 
leave Template Path Hints set to Yes). If you now look at the frontend of your 
Magento store, you'll see that the block name hints have appeared, displayed to the 
top-right of each block:
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 The footer area also has the block and template path name values displayed in a 
similar manner:
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 If you again look at the search feature, now with Block Name Hints enabled, you see 
that the value for the block name is displayed as Mage_Core_Block_Template:

The block name hints show you how the block is classed within the framework used 
to build Magento. So, Mage_Core_Block_Template tells you that this block is classed 
as a 'block template' within Magento, which is useful when it comes to defi ning the 
type attribute in your theme's layout fi les. Corresponding layout for this block may 
look like the following example taken from the catalogsearch.xml fi le in the /app/
design/frontend/base/default/layout directory, with the type attribute defi ned 
as core/template:

<reference name="header">
 <block 
  type=”core/template”

  name=»top.search»
  as="topSearch"
  template="catalogsearch/form.mini.phtml"/>
</reference>

More information on block names
You can fi nd more information on block names 
and others in the Magento documentation at 
http://docs.magentocommerce.com.

 As an additional example, take the following XML layout fi le, that adds a static block 
called widget created in Magento's CMS at the right-hand column of your theme:

<reference name="right">
 <block type="cms/block" name="widget" after="-">
  <action method="setBlockId">
   <block_id>widget</block_id>
  </action>
   </block>
</reference>
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Here the type attribute tells Magento to expect cms/block type content, that is 
displayed in the block name hints tools as Mage_Cms_Block_Widget_Block.

In contrast to the template path hints, which displayed the relative path within your 
Magento installation, the block name hints display a more abstract value which is 
used in Magento XML layout fi les.

Restricting who can see the hints
  The template path hints and block name hints are really useful for theme designers 
such as yourself, but they could cause confusion if you're working on a live Magento 
store to make minor changes. Luckily, Magento allows you to specify IP addresses 
that are able to see these hints, leaving usual customers to browse your store 
uninterrupted.

Within the System | Confi guration area of Magento's administration panel, remain 
in the Advanced | Developer area you were previously viewing to enable template 
path hints and block name hints. Expand the Developer Client Restrictions section 
of the page:
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Uncheck the checkbox for the Use Website fi eld, and enter your IP address(es) in to 
the Allowed IPs (comma separated) fi eld:

If you want to allow multiple IP addresses to view this feature of Magento, simply 
separate them with a comma, such as 123.123.123.123, 123.123.123.124.

Finding your own IP
You can detect your IP by using a service such as What Is My IP? 
(http://www.whatismyip.com) or What Is My IP Address? 
(http://whatismyipaddress.com).

You should now be able to see the block name hints and template path hints, while 
others looking at your Magento store will not see these.

A brief guide to XML
 Layout fi les in Magento make use of XML—eXtensible Markup Language. It can be 
baffl ing to see XML for the fi rst time—especially if you're not familiar with XHTML, 
but it's quite simple.

There is one simple rule to creating well-formed XML: every element must close. 
An element in XML can close in two ways.

• The element can self-close
• The element can be closed with a closing tag of its own type
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Self-closing elements in XML
  A self-closing element in XML is an element which closes itself. Take as an example, 
the XML element <thing>. Normally, this element would look like the following:

<thing>Some optional data</thing>

If this element self-closed, it would look like the following: 

<thing />

If you want to encapsulate data in the <thing> element, it might look like 
the following:

<thing data= "some data " />

Closing XML elements normally
  The other way to close an XML element is with a closing tag of the opening tag's 
type. So, with the <thing> tag, a valid XML element would look like:

<thing>Value (if any)</thing>

Entity escapes in XML
  As in HTML (Hyper Text Markup Language) and XHTML, XML requires some 
characters to be escaped to prevent data in the XML fi le from being misinterpreted. 
The characters that you'll need to watch out for in your XML fi le are:

Character Description Escape
& Ampersand &amp;
< Less than &lt;
> Greater than &gt;
' Apostrophe &apos;
" Quotation mark &quot;

For example, if you wanted to display A & B > C < D 'E' "F" in our XML fi le, it 
would look like the following:

A &amp; B &gt; C &lt; D &apos;E&apos; &quot;F&quot;

Now that we have a better grasp of XML, we can look more closely at changing the 
layout using Magento's XML layout.
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Changing a page's layout 
  There are three ways you can change the layout of a page within Magento:

1. On a page-per-page basis, if it is controlled through Magento's content 
management system (CMS), through a drop-down list of selectable page 
layouts

2. Through Magento's CMS, in the Design tab's Layout Update XML fi eld
3. Through Magento's XML layout fi les

For your reference, both of these methods are covered next.

Changing a page's layout through Magento's 
administration panel
 Log in to your Magento installation's administration panel (located at http://www.
example.com/magento/admin if your installation of Magento is located at http://
www.example.com/magento). Navigate to CMS | Pages:

 Here, you'll see a list of pages that are managed by Magento's CMS:
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Take a note of the value URL Key that corresponds to the page with a value in the 
Title column of About Us. In this case, the value we need is about: 

By default: imported sample data
This value is set to about-magento-demo-store if you've 
imported Magento's sample data in to your store.

To view this page in the frontend of your store (that is, the view that your customers 
will see), type the address of your Magento installation in to your browser's address 
bar and then append the value displayed in the URL Key column you just saw:

Once the page is loaded, you will see that the About Us page has a three-column 
layout:
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 If you look more closely in Magento's administration panel, under the Design tab 
at the left-hand side (displayed once you are editing the page in Magento's CMS), 
however, you'll see that this page's layout is set to 1 column:

If you disable the editor with the Show/Hide Editor button and look at the HTML 
view in the text editor provided, you will see that the three columns are created 
within the content in the CMS, referencing CSS classes .col3-set that surrounds 
three <div>s; .col-1, .col-2, and .col-3:
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 Switch back to the editor by clicking the Show/Hide Editor button again, replace the 
fi ller content for the about page with something relevant to your store:

 To change the page's layout, select the Layout drop-down list and select the 2 
columns with left bar option:

Click on the Save Page button to the top-right of the screen to complete the change:
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If you now refresh the page on the frontend of your Magento store, you'll see the 
left column, containing a callout (advertisement) and a registration form for the 
newsletter feature of Magento: 

Customizing a Magento page through Layout 
Update XML fi eld
 To change a page's layout through the Magento CMS's Layout Update XML fi eld, 
navigate to the page you wish to change within the CMS section of your Magento 
administration panel. In the left-hand side of your screen, select the Design tab:
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Prepare the XML layout you wish to use to change this specifi c page. In this case, 
you will add the 'callout' advertisement back to the left-hand column of your store:

<reference name="left">
 <block type=”core/template” name=”left.permanent.callout” 
template=”callouts/left_col.phtml” />

</reference>

 If you now click on the Save Page button at the top-right of your administration 
panel and return to your Magento store's frontend to view the page you have just 
edited (in this example, it was the About Us page), you should see the callout appear 
in the page's left-hand column:

You successfully used the Layout Update XML fi eld in Magento's CMS to change 
your store's layout!
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Customizing a Magento page through layout 
fi les
 While some pages in your Magento store can have their layout altered through the 
CMS, other pages must have their layout modifi ed through Magento XML fi les. 
In this example, you will see how to change the layout of the checkout page in 
Magento. Firstly, look at the frontend of your store's Checkout:

Locating Magento's checkout
You can locate the checkout in your Magento store by clicking the 
link labeled Checkout below the search box in Magento's Default 
theme, or by visiting http://www.example.com/magento/
checkout/cart, assuming your Magento installation is at 
http://www.example.com/magento/.

 If you wanted to change the layout of this view in your Magento store to display 
two columns, we need to locate the layout fi le that controls this particular view. 
To do this, you may fi nd it helpful to (re)enable the template path hints tool as 
described previously.

As the Default theme is currently in use on the store, the default layout for the 
checkout view is defi ned in the checkout.xml fi le in the app/design/frontend/
base/default/layout directory. If you open this fi le, you'll see that the layout is 
defi ned within the shopping_cart_index handle with the following XML:

<reference name="root">
 <action method="setTemplate"><template>page/1column.phtml</
template></action>
</reference>
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While in Magento 1.3 you might have edited the layout in this fi le directly, to make 
sure our version of Magento 1.4 is as upgrade-proof as possible, you will need 
to create a checkout.xml fi le in the Default package's directory: app/design/
frontend/default/default/layout. You may fi nd that you need to create the /
layout sub-directory here, if no other layout changes have been made in this theme. 
In the new checkout.xml fi le, copy and paste the entirety of the old checkout.
xml in the app/design/frontend/base/default/layout directory and locate the 
following XML:

<action method="setTemplate">
<template>page/1column.phtml</template>
</action>

Replace the value in the <template> element by changing this to the following:

<action method="setTemplate">
<template>page/2columns-left.phtml</template>
</action>

 The path set within the <template> element is relative to the /template directory, 
following Magento's hierarchy you saw described in an earlier chapter. If you now 
refresh the checkout page once uploading the checkout.xml to the app/design/
frontend/default/default/layout in your Magento installation, you should see 
the updated layout affect it:

Notice that the left-hand column is empty: you will need to remove another line from 
the new checkout.xml fi le to see content appear here. Locate the lines that read:

<checkout_cart_index translate="label">
 <label>Shopping Cart</label>
 <remove name="right"/>
 <remove name="left"/>
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Comment out the line that reads <remove name="left"/> as follows:

<checkout_cart_index translate="label">
 <label>Shopping Cart</label>
 <remove name="right"/>
 <!--<remove name="left"/>-->

If you now upload this fi le again and refresh the Checkout page, you'll see the fully 
updated layout changes:

Default and non-default handles in 
Magento layout
 As you saw previously, Magento has two types of handles that it uses within layout 
fi les: 

1. Default handles, which affect (almost) every page in your Magento store
2. Non-default handles, which can be used to affect the layout of specifi c pages 

within your Magento store

What is a handle?
 A handle is a reference name that Magento uses to refer to a particular view (or 
cluster of views) in your Magento store. For example, the <cms_page> handle used 
later controls the layout of pages in your Magento store created through the content 
management system (CMS).
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The default handle
 The <default> handle defi nes what is the default behavior for a layout within 
a particular view. So, if layout for the Checkout view in Magento is defi ned for 
the default handle to show a left-hand column in a two column layout, this is the 
layout that you will see in your store, unless you use a non-default handle to change 
the layout for a particular view in that Magento feature. For example, you could 
change the one-page Checkout's view with a non-default handle to help simplify a 
customer's options when it comes to checking out from your store.

Non-default handles
 If the handle is not <default>, the updates in the nested XML beneath it will apply 
to the relevant page(s) in your Magento store. Let's have a look at part of the cms.
xml XML layout fi le from Magento, located in the app/design/frontend/base/
default/layout directory:

<layout version="0.1.0"> 
<!-- omitted layout XML -->
    

    <cms_page>
        <!-- omitted layout XML -->
        <reference name=”content”>

            <block type="cms/page" name="cms_page"/>

        </reference>

<!-- omitted layout XML -->
    </cms_page> 
<!-- omitted layout XML -->
</layout>

Layout handles for CMS pages
Magento does not provide a layout handle for each page in your 
Magento store, so it's actually only possible to affect all CMS-controlled 
pages in your store through XML layout fi le changes, though you can 
change individual page's layout through the CMS interface as described 
previously.

The <default> handle applies layout to any page which has its layout defi ned by 
the cms.xml fi le. The non-default handle in the layout is <cms_page>, which controls 
the layout for pages created in Magento's CMS. The previous layout simply tells 
Magento where to insert the page's content.
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Useful handles in Magento
 Some useful layout handles in Magento—the identifi ers which allow you to single 
out a particular page or section of your Magento store are as follows:

XML handle Page it identifi es in Magento XML layout fi le 
the XML handle is 
referenced in

catalog_category_default The default view for a 
category of products.

catalog.xml

customer_account The customer account page, 
shown when a customer is 
logged in to their account on 
your store.

customer.xml

catalog_product_view The product page view (that 
is, a page which displays an 
individual product).

catalog.xml

cms_page Pages created with Magento's 
content management system.

cms.xml

checkout_cart_index The checkout's 'index' (that is, 
default) view

checkout.xml

cms_index_defaultnoroute The default error page for the 
404 'not found' error

cms.xml

cms_index_defaultindex The homepage of your 
Magento store

cms.xml

There are many other handles available to you, but as Magento expands these will 
change and evolve.

As you're only wanting to theme Magento, you shouldn't have 
to change these handles (instead, you will be referencing them in 
layout fi les), but it can still be useful to know what they do.
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Summary
In this chapter, you've looked into what template path hints and block name 
hints can do to help us theme Magento and in to the basics of a Magento 
theme's layout fi les:

• Some useful defi nitions used in Magento for layout
• Customizing layout using the CMS and by editing Magento XML layout fi les
• A guide to handles within Magento layout fi les
• An introduction to XML
• Changing page layout in Magento through XML layout

In the coming chapters, you will begin to create a Magento theme from scratch.
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Where to buy this book 
You can buy Magento 1.4 Themes Design from the Packt Publishing website: 
https://www.packtpub.com/magento-14-themes-design/book 

Free shipping to the US, UK, Europe and selected Asian countries. For more information, please 

read our shipping policy. 

Alternatively, you can buy the book from Amazon, BN.com, Computer Manuals and 

most internet book retailers. 
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